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2011  PROGRAM  

PRESENTATIONS  

Month  Topic  Coordinator(s) 
May 11  Photographing  the 

remote  regions  of 
China 

Pele  Leung 
(guest) 

June 8  Aperture,  focal 
length  and  depth 
of field 

Doug  and 
Chris 
Crawford 

July 13  tba   
August 10  Artificial lighting  Kim Barnabas 
September 7  tba   
October 12  Macro  Warren 

Colledge,  Ken 
Crawford  & 
Graeme Kruse 

November 9  tba   
December 7  AGM  +  Show  and 

Tell 
 

TOPICS – TO BE ALLOCATED 
• CT Photographer (guest) 
• Photoshop workflows for photography 
• Street photography 
• Wildlife photography  ‐ Helen Hall 

EXCURSIONS  
 
Month / 
Date  Location  Coordin‐ 

ator(s)  Comments 

May    Giles 
West 

 

June  tba     
July  tba     
August   Artificial 

lighting 
Kim 
Barnabas 

Burns Club 
‐ tbc 

September  Eden 
weekend 

Giles 
West 

 

October  Wind 
Farm 

Peter 
Bliss 

 

November  tba     
December  tba     
 

WE ARE IN NEED OF A TREASURER 
Unfortunately  our  hardworking  Treasurer  has  had 
to resign. She will be missed!  
As  a  result  we  are  seeking  nominations  for  the 
position.   If you are  interested and wish  to discuss 
what  would  be  involved,  please  feel  free  to  call 
Shane Baker on 6231 0965 asap so we can formalise 
the new Treasurer at the May meeting.  

APRIL  27  DIGITAL  SIG  MEETING  –  
CONVERTING  TO  B&W  

1. Camera  Raw  –  non‐destructive  (does  not 
alter  contents original  file;  it  adds what  is 
called  a  ‘sidecar’  to  the  file  so when  it  is 
opened by Adobe Camera Raw – a plug‐in 
that comes with PS Elements and PS CS all 
versions  –  the  contents  of  the  ‘sidecar’  is 
applied) 
HSL/Grayscale  

2. Photoshop CS3 
Grayscale  –  destructive,  discards  colour 
information of  file  that  cannot be undone 
at a later stage (if using this method always 
work on a copy of the original file).  
Image>Mode>Grayscale 
No direct control over  the conversion. Any 
changes must be done while  in RGB mode 
and then converted – much trial and error! 
 
Layers – non‐destructive 
Add and adjustment layer 
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Layer>Adjustment Layer>Black and White 
Make adjustments to appearance of  image 
by moving  the sliders. Can  ‘tint’  the  image 
by  ticking  TINT  box  and  making 
adjustments  using  Hue  and  Saturation 
sliders.  Can  be  further  refined  by  adding 
other Adjustment Layers such as Brightness 
and Contrast.  
 
Duotone  –  destructive  (requires  file  to  be 
converted  using  Grayscale,  if  using  this 
method  always  work  on  a  copy  of  the 
original file).  
Mode>Grayscale  followed  by 
Mode>Duotone  (Alternatively  you  can 
derive  your  grayscale  image  by  using  the 
Layers  method.  This  enables  you  to 

alter/manipulate  the  appearance  of  the 
grayscale  image  prior  to  converting  it  to 
Grayscale  (Photoshop  still  sees  it  as  a 
colour  image  until  you  do  this)  via 
Image>Mode>Grayscale.   All the  layers will 
have  to  be  flattened  ‐  Layers>Flatten  to 
enable  Duotone  can  be  selected).  Then  in 
the drop down menu in the Duotone ‘Type’ 
box  select  Duotone  –  selections  are 
Monotone,  Duotone,  Tritone  and 
Quadtone. Click on  the  second  colour  and 
select  from  the range of standard Pantone 
colours displayed. 

3. Plug‐ins for Photoshop 
Nik Software – Silver Efex (EUR 200);  

 
 

INDUSTRY  NEWS  
 

COMPANY NEWS  

GETTY  IMAGES  ACQUIRES  PICSCOUT  

Getty  Images  has  acquired  PicScout,  a  leader  in 
identifying  image  use,  metadata  and  licensing 
information on the web.  

This  acquisition  will  build  and  grow  upon  Getty 
Images’  existing  range  of  products  and  services, 
enabling Getty  Images to amplify  its digital content 
licensing  expertise  and  leverage  PicScout’s 
technology  in developing new  image  identification 
tools  for  customers.   Getty  Images  will  invest  in 
PicScout’s  technology and continue  to work across 
the  entire  image  industry,  to  improve  and  expand 
protection of  Intellectual Property,  thus ensuring a 
stronger overall content licensing industry.  

The PicScout brand will remain, with Getty  Images’ 
global  distribution  channels  and  platforms 
increasing  international  customers’  access  to 
PicScout’s products and services. 

The  acquisition  was  driven  by  the  opportunity  to 
grow and expand PicScout’s business to the benefit 
of our contributors,  image partners, customers and 
industry as a whole. 

FIRMWARE  &  SOFTWARE  UPDATES  
 
SOFTWARE  

NIKON  CAPTURE NX  AND  CAMERA  
CONTROL  PRO  SOFTWARE  UPDATED  

Nikon  has  announced  version  2.2.7  of  its  Capture 
NX  and  version  2.9.0  of  the  Camera  Control  Pro 
software.  The  latest  versions  extend RAW  support 
to the D5100 digital SLR. 
Information and to download Capture NX v2.2.7 

Information and to download Camera Control Pro 
v2.9.0

PHOTOSHOP  LIGHTROOM  3.4  AND  
CAMERA  RAW  6.4  RELEASED.    

Adobe  has  released  the  final  versions  of  updates 
Photoshop Lightroom 3.4 and Camera Raw 6.4. The 
latest  versions  provide  final  RAW  support  for 
thirteen  additional  cameras  including  the  Canon 
EOS  600D/T3i  and  1100D/T3,  Nikon  D5100  and 
Fujifilm  X100,  alongside  profiles  for  over  25 more 
lenses. The updates also address a number of issues 
reported via customer feedback. 
Click here to download Adobe Photoshop Lightroom v3.4 
(Windows)

Click here to download Adobe Photoshop Lightroom v3.4 (Mac)

Click here to download Adobe Camera Raw v6.4 (Windows)

Click here to download Adobe Camera Raw v6.4 (Mac)

NEAT  IMAGE  V7  PLUG‐IN  FOR  
PHOTOSHOP  (WINDOWS)  
Neat  Image  team  is  pleased  to 
introduce  the 7th generation of  its 
noise  reduction  solution  for digital 
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photography  that  inherits  and  refines  the  highest 
quality and efficiency traditionally delivered by Neat 
Image. 
The  new major  version  of Neat  Image  plug‐in  for 
Photoshop  includes  the  following  changes  and 
improvements: 
• Higher performance:  the  first GPU‐accelerated 

version of Neat Image plug‐in for Photoshop 
o CUDA  support:  faster  noise  reduction 

using modern CUDA‐compatible GPUs 
For example, on NVidia GTX 470 Neat 
Image  is  about  x2.5  faster  than  on 
Intel  i7 and x3‐x7  faster  than on  Intel 
i5 or Core2 Duo 

o Multiple GPU support 
Neat  Image  works  even  faster  with 
two or more CUDA GPUs 

o CPUs and GPUs working together 
Neat Image can use CPUs and GPUs at 
the  same  time  for  even  faster 
processing 

o Automated  optimization  of 
performance  settings  for  multi‐core, 
multi‐CPU and multi‐GPU systems 

 Built‐in  benchmark  to 
measure  image  processing 
speed on specific hardware 

 Built‐in  performance 
optimizer  in  Neat  Image 
Preferences 

o Additional  performance  optimizations 
in the filter code (32‐bit version) 
Faster  image  processing:  x1.2  faster 
than in previous version 

• Neat  Image plug‐in  for Photoshop now  comes 
in two builds: 32‐bit and 64‐bit 

o the 64‐bit plug‐in continues to support 
the latest 64‐bit versions of Photoshop 
CS5 / CS4: 

 Adobe Photoshop CS5 (64‐bit) 
 Adobe Photoshop CS4 (64‐bit) 
 other 64‐bit hosts 

o the 32‐bit plug‐in  is added  to  support 
32‐bit host applications: 

 Photoshop CS5  (32‐bit)  / CS4 
(32‐bit) / CS3 / CS2 / CS / 7 / 6 
/ 5 

 Photoshop Elements 9 / 8 / 6 
/ 4 / 3 / 2 

 other 32‐bit hosts 
o both 64‐bit and 32‐bit versions can be 

used  at  the  same  time with  different 
host applications 

• Improved user interface 
Both  32‐bit  and  64‐bit  versions  of  the  plug‐in 
now have the same GUI with: 

o Redesigned  graphics  elements 
throughout the plug‐in 

o More  intuitive  noise  profile  equalizer 
with adjustable graphs 

o Improved  image  viewer  with  several 
viewer  modes  and  adjustable 
brightness 

o Component  viewer  built  directly  into 
image viewer 

o Automated  preview  (full  window  or 
selected area) 

• More improvements 
o Support for 32‐bit per channel  images 

(in Pro plug‐in, in addition to 8‐bit and 
16‐bit  ones)  to  enable  HDR  post‐
processing workflows 

o Smart  Profile:  automatically  uses  two 
different profiling methods and selects 
the  better  resulting  profile  for  more 
accurate noise reduction 

o Improved  metadata  (EXIF) 
compatibility  with  the  latest  Nikon 
cameras: 
D7000,  D3100,  P500,  P300,  P7000, 
S8100, etc. 

Pricing and Availability 
Neat Image plug‐in for Photoshop (Win) is available 
in three editions: 

o Demo  plug‐in:  free  edition  with 
limited functionality; free; download 
This  edition  demonstrates  the 
capabilities of Neat  Image and can be 
used to process small  images for non‐
commercial purposes. 

o Home  plug‐in:  supports  8‐bit  (per 
channel) images; $39.90; purchase 
This  edition  is  intended  for  home 
users.  Supports  8‐bit  images  (like 
JPEGs produced by compact cameras). 
The  perfect  match  for  Photoshop 
Elements. 

o Pro plug‐in: supports 8‐bit, 16‐bit and 
32‐bit images and works in Photoshop 
actions  and  smart  filters;  $79.90; 
purchase 
This  edition  is  intended  for 
professionals  who  process  large 
amounts  of  images  and  work  with 
high‐bitdepth images. 
The best choice  for  the  full version of 
Photoshop. 

Licenses for non‐Demo editions of Neat Image plug‐
in  for  Photoshop  can  be  ordered  in  the  Purchase 
page. 
Multi‐user  licenses  are  available  with  volume 
discounts. 
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http://www.neatimage.com/win/photoshop/purchase2.html
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Neat Image plug‐in for Photoshop (Win) can also be 
purchased in a bundle with other version(s) of Neat 
Image. 
The product is delivered as a digital download. 
Upgrading from older versions 
The  new  major  version  7.0  of  the  plug‐in  for 
Photoshop  (Win)  is  either  paid  or  free  upgrade, 
depending on the previously purchased version. 
Please  find  more  details  in  the  version  upgrade 
page. 
• New noise profiles in the library 
Many  new  profile  sets  have  been  created  and 
submitted to the profile library by generous users of 
Neat Image. 
We  thank  all  the  contributors  who  build  new 
profiles  for  the  community  of  Neat  Image  users. 
Please  also participate  in building new profiles  for 
digital  cameras  and  scanners.  Using  the  Batch 
Profiler  in Neat  Image  plug‐in,  you  can  easily  and 
quickly build  a  profile  set  for  your  camera.  Please 
see  the  user  guide  (specifically,  the  "Device  noise 
profiles" section) for additional information. 

BLURB  LAUNCHES MOBILE  MEDIA STORY  
APP  
New  mobile  platform  enables  anyone  to  quickly 
compose and share media stories directly from their 
iphone. 

Blurb,  the  global  creative  publishing  platform 
announced  its  new mobile  publishing  application, 
Blurb  Mobile.   Designed  to  enable  easy  and  fast 
story  creation  using  rich media  content,  including 
photos, videos and audio, the stories can be shared 
via the author’s existing social networking channels 
(including  Facebook  and  Twitter),  by  email,  or  via 
their own Blurb channel.  

Produced by individuals with a passion for capturing 
life’s moments, Blurb Mobile  stories  are  engaging, 
inclusive,  fun  and  instantly  sharable.  The  Blurb 
Mobile  iPhone  app  enables  easy  media  editing, 
including  rotating,  cropping,  scaling,  and  drag  and 
drop  sequencing,  plus  geotagging,  which  can  link 
the story  to a  location on a map.  Once  the media 
has  been  composed,  the  author  can  add  text  and 
voice  captions  to each of  their  images  to  create  a 
complete  and  highly  personalised  narrative. 
Additional  personalisation  includes  the  ability  to 
choose from seven unique visual themes. 

By  introducing  an  easy  to  use,  yet  powerful 
interface,  a  Blurb  Mobile  story  can  range  from 
sharing a personal moment with friends and family, 
to  a  real‐time  report  from  a  front‐line 
photojournalist covering breaking news.  

“Blurb  is  known  for  two  things:  helping people  to 
tell their stories visually and then enabling them to 
share their work directly with their audience,” said 
Eileen  Gittins,  CEO  and  Founder,  Blurb.com.   “To 
date,  the medium  of  choice  has  been  the  printed 
book;  but  that’s  all  changing. With  the  release  of 
Blurb Mobile,  people will  now  be  able  to  capture 
life’s  great  moments  –  large  and  small,  in 
wonderfully  rich  story  form  and  then  share  their 
stories on  the  fly, using any media on  their phone 
including voice, video  text and  image. All  in under 
90 seconds.” 

Putting  media  into  motion  means  customers  can 
quickly create, share and view personal stories that 
use  photos,  video  and  audio.  Designed  to 
encourage contextual experimentation on  the part 
of the author and discovery by the audience, Blurb 
Mobile  is  about  entertainment  and  personal 
storytelling  that  can  be  instantly  shared  with 
friends, family, or a broader audience. 

Currently  available  on  the  iPhone, Blurb Mobile  is 
free  to  download  and  each  customer  receives  a 
story  channel  on  Blurb.com/mobile  to  share  their 
stories.  In  addition, Blurb Mobile  Plus provides  an 
in‐app  upgrade  path  for  customers  seeking 
additional  photo,  video  and  audio  capability.  All 
stories can be made public or private. 

FIRMWARE  

NIKON  RELEASES  FIRMWARE  V1.02  FOR  
D7000  
Nikon  has  posted  a 
firmware  update  for  its 
D7000 digital SLR. Firmware 
v1.02 fixes a host of bugs: 

• An issue that 
prevented the opening 
of movies recorded with the D7000 in certain
movie editing software applicatio

 
ns has been 

reso
• 

e 

 at extremely 

inte d.   
• 

 
genta 

cast.
• d 

for heading information when the GP‐1 GPS 

lved.   
When the camera was connected to a 

television via the A/V cable and a movie was 
played back, playback was normal the first tim
but when the movie was played two or more 
times, the sound was played back
low volume and seemed to play 

rmittently.  This issue has been resolve
When white balance for RAW images 

created using the camera’s image overlay 
function was fine tuned with Capture NX 2 or
ViewNX 2, the images acquired a ma

  This issue has been resolved. 
An issue that caused 0.00” to be displaye
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unit was connected to the camera has been 
resolved so that ‐‐‐.‐‐ is now displayed.  

• When Viewfinder virtual horizon was the 
role assigned to the Fn button or the preview 
button and the applicable button was pressed, 
errors in the virtual horizon indicator were 
displayed.  This issue has been resolved.  

• The following errors in Help displays have 
been resolved.   

 "Maximum sensitivity" help was 
displayed for shooting menu>ISO 
sensitivity settings>On or Off help.  
 German help displayed “Select focus 
priority for AF‐S mode.” for Custom 
Settings>a1: AF‐C priority selection 
help . 

Download firmware v1.02 for Nikon D7000 here. 

CANON  UPDATES  FIRMWARE  FOR  EOS  7D

 
EOS 7D Firmware Update Version 1.2.3 

Firmware  version  1.2.3  incorporates  the  following 
fixes. 

1. Fixes a phenomenon  in which  the settings 
of  the  Speedlite  Transmitter  ST‐E2  revert 
to  the  default  settings  when  both  the 
camera  and  the  ST‐E2  are  set  to  auto 
power off. 

2. Fixes  a  phenomenon  in which  the Macro 
Ring  Lite  (MR‐14EX,  MT24‐EX)  and  slave 
flashes  do  not  sync  while  shooting 
wirelessly. 

Firmware version 1.2.3 is for cameras with firmware 
up  to  Version  1.2.2.  If  the  camera's  firmware  is 
already Version 1.2.3,  it  is not necessary to update 
the firmware. 

Available from Canon Japan here. 
 
EQUIPMENT  

SAMYANG  35MM 1:1.4  AS  UMC  
Samyang  announced  that  wide‐angle  Samyang 
35mm 1:1.4 AS UMC with Canon EF and Nikon AE 
mounts, has been released for sale today. 
Samyang  35mm  1:1.4 AS UMC  is  now  available  in 
two versions: with Canon EF and Nikon AE mount. 
The  remaining  models,  i.e.  Four‐thirds,  Pentax, 
Samsung NX and Sony Alfa are  to be  released at a 
later date.   
Samyang  35mm  1:1.4  AS  UMC  is  an  optically 

sophisticated  bright  (f/1.4)  wide‐angle  lens  with 
focal  length  of  35  mm.  It  was  designed  to  work 
especially  with  full‐frame  sensor  cameras, 
nevertheless  it  may  be  also  used  with  cameras 
featuring  APS‐C/DX  and  Four‐thirds  sensors.  The 
device's optical construction comes with two lenses 
with  high  refractive  index  (HR)  limiting  its weight 
and dimensions. One aspherical lens (AS) protecting 
against  chromatic aberration was also used.  High‐
quality multi‐layer and anti‐reflexive coatings (UMC) 
increase  the  contrast  and  allow  to  generate more 
natural colours. Samyang 35mm 1:1.4 AS UMC  lens 
takes  advantage  of  the  so  called  "gliding  lenses" 
allowing  to  maintain  high  image  quality  with 
minimum focusing distance. AE model, intended for 
Nikon DSLR cameras  feature a microprocessor unit 
allowing  to  have  full  control  over  the  exposure 
parameters  and  freely  use  i‐TTL  flash  control 
technology.  Data  on  focal  length  and  available 
apertures is recorded in EXIF format. 
Price 
Samyang 35mm 1:1.4 AS UMC with Canon EF mount 
– EUR 399 
Samyang 35mm 1:1.4 AS UMC with Nikon AE mount 
– EUR 419 (gross) 

NIKON  ANNOUNCES  THE  AF‐S  NIKKOR 
50MM  F/1.8G  
A bright and fast, normal 50mm fixed focal  length 

lens  with  a 
maximum 

aperture  of 
f/1.8 
Nikon  Inc. 
announced the 
AF‐S  NIKKOR 
50mm  f/1.8G 
lens,   a  fast, 
compact  lens 

that  affords  photographers  the  versatility  of  the 
classic 50mm focal length and the benefits of a fast 
aperture for photos and D‐movies.  Whether a new 
D‐SLR  enthusiast  or  a  seasoned  pro,  users  will 
appreciate  the  tack‐sharp  image  quality,  extreme 
low‐light  performance,  shallow  depth  of  field  and 
Nikon  core  technologies  that  improve  upon  the 
original to make a great lens even better. 
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Adoption  of  the  50mm  focal  length  and  f/1.8 
maximum  aperture  enables  the  simple  capture  of 
images exhibiting pleasing blur  characteristics with 
hand‐held  shooting,  even  in  dimly  lit  indoor 
settings.  This  lens  is  perfectly  suited  to  the 
spontaneous  capture of  the  intended  subject with 
snapshots and  landscape photos. When  this  lens  is 
used  with  a  Nikon  DX‐format  digital‐SLR  camera, 
the effective angle of view is equivalent to that of a 
lens with a 75‐mm focal length. 

• A  new  optical  design  utilizing  an  aspherical 
lens  element  enables  superior  rendering 
performance 

• Equipped with  a  Silent Wave Motor  (SWM) 
for extremely quiet autofocusing 

• Equipped  with  two  focus  modes,  M/A 
(autofocus  with  manual  override)  and M 
(manual) 

• A size and weight that makes it very portable 

SONY  HVLF43AM  EXTERNAL  FLASH  UNIT  

Sony has announced the HVL‐F43AM external flash 
for its range of Alpha SLT and SLR cameras. 

Illuminate your subjects with total 
control  using  this  versatile  flash 
unit.  With  a  powerful  output  of 
GN43  (105mm  ISO100  m)  and 
durable  design  it's  ideal  for 
everyday shooting and demanding 
indoors or outside assignments.  

• Quick Shift Bounce system 
• Dust and moisture resistant design 
• Wireless Ratio Control control up  to  three 

groups of flashes 
• Power level switchable in 22 levels 
• Quick 2.9 sec (approx.) recycling time 
• Intuitive, easy‐to‐read rear panel display 

 
 

WHAT’S  ON  
 

 
Frank Hurley: Journeys into Papua 
http://www.naa.gov.au/whats‐
on/exhibitions/frank‐hurley‐journeys‐into‐
papua/index.aspxThese  remarkable photographs by 
renowned Australian photographer and adventurer 
Frank Hurley were taken during two expeditions to 
Papua  in  the 1920s. An  important historical  record 
of our Pacific neighbour, the images shed light on a 
little‐known aspect of Hurley's work. 
When: 18 March to 29 May 2011 

Open daily from 9am to 5pm.  
Where: National Archives of Australia 

Queen Victoria Terrace 
Parkes ACT 2600 

 
 

Stuart  Campbell’s  portraits  record  the  actors, 
directors and writers of  the  cinema  renaissance of 
the 1980s known as the Australian New Wave. 
Stuart  Campbell  (1951–2009),  born  in  Ballarat 
Victoria,  studied at Swinburne Technical College  in 
Melbourne where his  love affair with photography 
began.  In 1972 he moved to Sydney and studied at 
the  National  Institute  of  Dramatic  Art.  After 
graduation  Campbell  played  on  stage  with  major 
theatre  companies  and  appeared  in  a  number  of 
films including Caddie (1976) and Starstruck (1982), 
and  on  television  in  Cop  Shop  and  Patrol  Boat 
among others. 
Campbell  had  modest  success  as  an  actor,  but 
excelled  as  a photographer.  In  the  early  1980s he 
began  taking  sensitive  portfolio  portraits  for  his 
friends. These  included actors such as Mel Gibson, 
Colin  Friels  and  Judy Davis,  and  filmmakers Gillian 
Armstrong and Peter Weir. Campbell stayed faithful 
to the sensuous darks and lights of black and white 
film,  valuing  the  richness  and  honesty  of  the 
medium.  Other  photographic  projects  included 
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taking  the notorious male centrefolds  for Cleo and 
celebrity portraits for Vogue.  
"Stuart  Campbell’s  gifts  as  a  photographer  were 
many but what made him unique was his ability to 
disarm  his  subjects  with  outlandish  wit,  shocking 
them  out  of  their  self‐consciousness  so  that  they 
revealed  more  of  themselves  than  they  had  ever 
intended" 
‐ author and friend, Lee Tulloch. 
When: 30 April ‐ 17 July 2011 
Where: National Portrait Gallery 
 

 
BOTANY BAY 2010 
Micky Allan & Steenus Von Steensen 
 

 
Micky Allan and Steenus von Steensen Tugboat (2010) 

...  Presented  in  two  rows  of  colour  photographs, 
Allan  and  von  Steensen  reveal  aspects  of  their 
collaborative  journey  through Botany Bay. The site 
where  Captain  Cook  met  the  original  Indigenous 
inhabitants  of  Sydney  in  1770,  it  is  a  significant 
location  in Australian history and everywhere  they 
find  contradiction: ancient and  recent, beauty and 
degradation, smart and daggy, familiar and strange. 
Even  their  medium  is  contradictory,  a  series  of 
photographs that attempt to complicate notions of 
factual  “reality”. With  the occasional  assistance of 
paint or glitter they generate a profound vision with 
unassuming works  that  characterise  the elemental 
magic that animates Botany Bay in many lights.  
 
When: 15th April to 21st May 2011 
Where: CCAS Gorman House 
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DIGITAL  IMAGING  SPECIAL  INTEREST  GROUP  –  CONVENOR  GRAEME  KRUSE  

DATES  
Fourth Wednesday of every other month: 
• June 22 
• August 24 
• October 26 

OTHER  TOPICS:  
• Curves 
• Masks and Layers 
• Processing RAW 
• Blending images 
• HDR 
• Other possible topics: 

o Alternatives to PhotoShop (Aperture, 
Lightroom, etc.) 

o PhotoShop  plug‐ins  ‐ PS  Plug‐Ins. 
Topaz products; Noise Ninja; Portrait 
Professional;  Photomatrix  HDR,  free 
and purchased, etc 

CLUB  OFFICE  BEARERS  
 
Position  Person  e‐mail address  Phone (ah): 
President    Shane Baker  shane@sb.id.au  6231 0965 
Sec/Treasurer  vacant 
Newsletter Editor  Warren Hicks  hicks@netspeed.com.au  6288 3689 
 
FOR  SALE /  WANTED  TO  BUY  /  FREE  TO  A  GOOD  HOME  
 

Email the editor to have your item included 

CLUB  SUPPORTERS  DISCOUNT  OFFERS  TO  MEMBERS  
 

 
mailto:enquire@theframingbusiness.com.au

The Framing Business 
Ground Floor 
32  Lonsdale  St  Braddon    ACT  
2612 Ph:  (02)  6262  6890  Fax: 
  (02) 6262 6893 

Discount  of  10–15%, 
depending on the job. 
Will do matt cutting only. 

FrameCo 
http://www.clubframeco.com/index.php

FrameCo 
23  Ceylon  Street,  Nunawading 
3131  Victoria  Ph:  03  8878  1700 
Fax:  03  8878  1750 
mailto:info@clubframeco.com

Offers to club members. 
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